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Overview

This article walks through the steps to change the names of the user field labels for your database, search by them, report (format) on them, and
utilize them as merge fields in the letter/email templates you create.

« Tip: Customers use custom user fields for all kinds of different things, some examples would include:
- Graduation Year
- Ask Amount
- Last Contact Date
- Next Contact Date
- School Attended
- Ethnicity
- Church Affiliation
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- Salary
- Religion
- Language

Outline

#1 Rename Custom User Fields

#2 Query (Search) by Custom User Fields

#3 Add User Fields into the Grid as Columns & Make them Updateable in the Grid View
#4 Utilize User Fields as Merge Fields in your Letter & E-Mail Templates

#5 Related Resources

#1 — Rename Custom User Fields

Navigate to the Contacts (Donors/Voters) list, and the General > User, Text tab.

KNOWLEDGE BASE www.trailblz.com/kb 2



http://www.trailblz.com/kb

&\ TrailBlazer

Organize.Leverage. Succeed. How to Rename User Fields, Query by Them, Add Them to the Grid as
Columns, and Utilizing Them as Merge Fields in Letter & E-Mail Templates

B) Settings Help
Application Menu « || <3 Search [ Reset || 4k New 0= ||} Of @ | File ~ Edit = |§pInclude Other | Contacts
[ElR:A=¥e] o
Tasks —4 i ] } ] )
G I
|Favont&ﬂ enera |I\ddr&zs|kbu5&‘1dd|ﬁthhﬂe|€anvasslﬁelalo:|&mbtﬂelFledgelEvm | Sales | Log | Admin | SQL |
- Calendar/Tasks | Name | Phone | E-Mail | Email Links | Profile | work |Demogmpm|j User, Text [le.er,Dat&sl User, Decimal | Cther |
=&y Contact ! I— E—

-8 Contacts -‘— @] Test User Field #1: + UserField & + UserField &

----- @ Addresses User Field 2; ~ UserField & = User Field 10:

----- Household . - . -

% mationshi . Uszer F?eld 3 +* lser F!eld T User Field 11:
-4y Contributions/Pledges User Field 4: ¥ UserField 8: User Field 12:
[]--{ﬁ. Product Sales
- Logs

(-5 Communications
#-{fik Financial
- System Manager
Ef Edit | % Include % Exclude B Sert 5 Format - m& Export &Print IEI Summary ED B (& Pivot
Contacts List [ -- enter search criteria above, then press "Search”™ -- ]
Ind ID Title l.L‘f;rtn . - ;';ﬁ . MI ?;pde”“ Address City State ‘Eigd . Eﬁ;"nee E’#;n .
@l o | || | | | | || | | }

The different places you can rename user fields are from the search panel (as shown below), within a contact’s record card, or by using the
customize labels list. In my example | chose to do it from the search panel.

Right-click on the user field label and select ‘Rename Label...’
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1. Right-click on the user field label you want to rename.

<5 Search % Reset | o New = | k) CF @ | File » Edit + | ) |§gInclude Other | Contacts
" 3

Favorites Gma\|m|m|m&|@m|ﬂam|m&|ﬁe@|5m|5a¢a | Log | Admin | saL |

| Name |Fhme|§Mai | Email Links | Profile | Work | Demographics | User. Text | User, Dates | User, Decimal | Other |

o \

Test User Fiel » lserField 5: ser Field 5:
Rename Label... |

ser Field 2: + |lserField &: ser Field 10:

User Field 2: k » UserField 7: User Field 11:
User Field 4: \ v UserField & User Figld 12:

2. Select '‘Rename Label...

=8 Edi - | H ' ' =1 P
S8 Edit | % Include % Exclude ) Sort B Format &Export &Prlnt @ Sumrmmary D] E [E] Pivot |

Contacts List [ -- enter search criteria abowve, then press "Search™ -- ]

Zip
Caode

Mame Mame Type

. Ind 1D Title| 125 e p| AOTESs | e City State
B o
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Give the new label a name, and click [OK]. In my example | called my User Field 1 label ‘Graduation Year'.

| Rename Label

Rename Label
= Default: User Field 1

Current: Test User Field £1

Mew: Graduation Year

2
f2) OK 1§ [@Canoel ]

1. Create a new name for your
user field.

The changes will affect all db users. My finished example is below.
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<3» Search Y, Reset | 45 New 0 | L) CF @ | File + Edit - | ) | S Include Other | Contacts
9

Favorites | General | Address | Household | Attribute | Canvass | Relation | Contrbute | Pledge | Event | Sales | Log | Admin | sQL |

| Name | Phone | E-Mail | Email Links | Profile | Work | Demographics | User. Text | User, Dates | User, Decimal | Other |

Graduation Year
User Field 2:
User Field 3:
User Field 4:

User Field &
User Field &
User Field 7:
User Field &:

User Field 5

User Field 10:
User Field 11:
User Field 12:

New user field 1 label (this change will sync for all other db users).

S8 Edit | % Include % Exclude ) Sort ) Format - ma Export &Print |§| Summary [D E [E] Pivet |
Contacts List [ -- enter search criteria abowve, then press “Search™ -- ]

Last " First Address . Zip Home

Ind 1D Title o Sl ML ooe Address City State Code Phone

=

Repeat these steps until the user fields you need to modify (text, date, and decimal) are changed accordingly. As of the time this article was written
there were 12 user text fields (6 of which offer drop-down menus), 3 user date, and 3 user decimal fields available. My finished example is below
where | renamed 10 out of 12 user text fields.
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There are more user fields under the 'User, Dates' &

Ex: 10 out of 12 user text fields renamed. User, Decimal’ fields.

<o Search . Reset | dk New m= L) O @ | File » Edit - | ) | S Include Other | Contacts
Q
Favorites | General | Address | Household | Attribute | Canvass | Relation | Coninbute | i Everi | Sales | Admin | saL |

| Name | Phone | E-Mail | Email Links | Profile | Work | Demographic} | User. Text | User, Dates | User, Decimal | |

Q

@ (Graduation Year = Native Language = Ed. Degree
Religion « Business P.O.C. + High School Attended
Church Affiliation = 1stChild Name  UserFidd 11:
Ethnicity = 2ndChild Name | serFieid 12

S Edit | % Include % Exclude (57 Sort B Format ~ ngxport &Print |§] Summary D] E [E Pivet

Contacts List [ -- enter search criteria above, then press "Search”™ -- ]

] Last First Address § Zip Home Bus Cell .
Ind ID Title Name e Mame I Type Address City State Code Phone Phone Phone Email

&) o ]

If you open a contact’s record card you can begin to record the new custom data in your user fields under the General > User tabs.
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Once your user fields have been configured you can begin to populate the
values under the General > User tabs within a contact's record card.

File - Edit - | | @ | [ &

@y 8t  Joel Kristenson [12796]

Title: Senar - r Home Address
. 5110 Golden Valley Rd
First Mame loel Apt 10
stonar e
Mo Photo
Last Name/Suffix Kristenson -
; Email Work Add
Prior Last Name jkristenson@trailblz.com r ress
. 620 Mendelssohn fve N
Nickname Suite 136
Co = []n dividual v] Golden Wallev. MK 55427-4350

ousehold | Gallery | Attribute | Poll | Relation | Contribute | Pledge | Event | Logs | Sales | Admin |

| Address | Contact | Profile | Work

User, Text (255 limit)
Graduation Year:
Religion:

Church Affiliation:
Ethnicity:

Mative Language:
Business P.O.C.:

User, Date

Leaves for \Winter Home:
Membership Expiration:
User Date 3:

I |
I! |ser I]he,r |
|ser, Text (255 limit)

2007 - 15t Child Name:
- 2nd Child Name:
Calvalry Lutheran - Ed. Degres:
Caucasian A High School Attended: Cook County High Schoal
English - User Field 11:

v User Field 12:

Ilzer, Mumbers (Decimals)
ser Decimal 1: 00

O E~ ser Decimal 2: 00
O E~ User Decimal 3: 00

8/ 1/2018 @~
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As new values are added to your user fields, you'll periodically want to update the unique search value (drop-downs) within your system by
following Application Menu > System Manager > Settings > Update Unique Search Value (Drop Downs)...
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@ Settings  Help
Application Menu

El=zad

Taszks

- & Calendar/Tasks
=By Contact

—[8f] Contacts

{8 Contact Relationships
+-“p Contributions/Pledges
#-i Product Sales
(- Communications
#-¢ji Financial
El% System Manager
[ System Galle
--1E| Lists
2= Settings
= Customize Labels
@8 Payment Gateway

“3» Search M. Reset | 45 New 0 L) OF @ | File - Edit - | ) | §gInclude Other
|

Favorites | General |Mdrﬁs I Household I Attribute | Canvass I Relation | Contribute | Pledge | Event | Sales

| Name | Phone | E-Mail | Email Links | Profile | Work | Demographics | User. Text | User, Dates | User, Deci

RIS ECIEEES

|§‘[| High School Graduation Year:  /n + [Mative Langusge:

Religion: » Business P.O.C.:
Church Affiliation: + st Child Name:
Ethnicity: 2nd Child Name:

-

Warning

ii This function will refresh (i.e., clear and reload) the Distinct Values table.

- Tools

Ramstad 1500 7th 5t 5
Rubald 441536 1/2 5t'W
Sutkus 502 Saint Paul Ave

Wi
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#2 — Query (Search) by Custom User Fields

You can now run your search queries by the user fields as you begin to populate data into those fields. My example is below where | queried for
everyone in my database who graduated high school in 1970 which produced 180 results.
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Example query by custom user text fields.

@) Settings  Help 3

Application Menu <<l <3 Search [, Reset | 4k New ™ | k) CF @ | File ~ Edit - | ) | SpInclude Other | Contacts .

E [za o o

ET;' | Favorted ~ General |M¢&B3|Housdﬂoldlktrbue|Cawass|H£lda‘.ion|Combue Pledge | Event | Sales |Log | Admin | SQL |

&~ § Calendar/Tasks | ame | Phone | E-Mail | Email Links | Profile | work |Damga*x:=ij A User, Text | liser, Dates | User, Decimal | Other |

- O™ B0 3% X BITFEG

@‘u High School Graduation Year: 1970 = Mative Language: '+ Ed Degres

Religion: Business POC.: +  High School Attended:
Church Affiliation: 1st Child Name: \User Field 11:
Ethnicity: 2nd Child Name:  UserFied 12

= ) - : =l Pi
.-Ei Edit | % Include % Exclude @Sort @Format EExport &Pnnt @ Summary D] B PI‘."Ot |

Contacts [ 180 records found ]
Ind ID Last Name = First Name I ?ydpde"‘““ Address City State (Z:igd . Eﬁ;”n'*e Email
10 Abbott Steven William Home 5533 Concord Ave Edina MM 55424 [952) 9299217
35 Adams Benito Home 2403 Ethel Ave Albert Lea MM | 56007 [507) 7209314
a4 Allmann Christine Marie Home 183 Malcolm Ave SE Minneapaolis MM 55414 [612) 3318321 Christine @Allmann.com
100 Alto Eradley o Home 3301 State Hwy Mo 169 Plymouth MM | 55441 [218) 741-7232
163 Anderson Kari Lisanne Home 2010 Knollwood Dr Fairmont MM 56031 (507) 235-3124 Kari@Anderson.com
190 Anderson Michael Einar Home 31233rd STW Minneapaolis MM 55403 [651) 646-7935
312 Baccam BRhonda Sue Home 15589 Avocet St NW Andover MM 55304 [763) 434 8922
Barnett Erin Maureen Home 809 Linden 5t 5 Marthfield MM 55057 (507) 645-7432 Erin@EBarnett.com
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« Tip: You can utilize sql wildcard search queries to find records where they ‘have a user field present’ or are ‘missing a user field’. For instance, to
find everyone in my database that has a high school graduation date | entered /n for ‘not blank’ in that field which provided 9,246 records:

Tip: Example query using sql wildcards to find all records that 'have’ data in a certain user field.

=3 Search [, Reset | g New m L) ¥ @ | File v Edit v | ) |8 Include Other | Contacts |
W

Favorites | ¥ General | Address | Household | Attribute | Canvass | Relation | Contribute | Pledge | Event | Sales | Log | Admin | saL |
| Name | Phone | E-Mail | Email Links | Profile | Work | Demographics | 4% User. Text | User, Dates | User, Decimal | Other |
Q% 00 0w x|EZFH @ s

@ High School Graduation Year:  /n = Native Language: w Ed. Degree:
Religion: = Business P.O.C. *  High School Attended:
Church Affiliation: / + 1stChild Name:  UserField 11:
Ethnicity: ~  2nd Child Name:  UserFied 12

Ef Edit | % Include % Exclude ) Sort B Format - mEExprcl'rt &F‘rint @ Summary I:D E [E] Pivot |

Contacts [ 9246 records found ]

Address Home .
Email

Last Mame & First Name Type Address City Phone

=

4629 York Ave S Minneapolis (612) 9209217 Martha@Aagard.com
(218) 5259215 Ariel@Aakhusoo.com

(718) 8259215

Aagard Martha Home
Aakhus Ariel i Home 1709 Bth St S Moorhead

Aakhus Cindy Home 19981 See Gull Rd Erainerd
19931 See Gull Rd Brainerd [218) 8259215

Steven@Aakhus.com

LR B L RY R ()

Aakhus Steven i Home
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#3 — Format User Fields into the Grid & Make them Updateable in the Grid View

You can add in the user field data as columns into your grid via formatting for reporting purposes. The columns will be renamed to whatever
you’ve named them as in your database, for example in my database | renamed User001 to High School Graduation Date.

You’ll begin this process by navigating to the list you want to build the report in (in my example it was the Contacts list), click on the Format drop-
down button, and select Columns.
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Z) Settings Help
Application Menu <3 Search ¥, Reset | 4k New 09 | L) CF # | File - Edit - | @ |§pInclude Other | Contacts |

Exao Q
Tasks

@& Calendar/Tasks | Name | Phone | E-Mail | Email Links | Profile | Work | Demographics | User. Text | User, Dates | User, Decimal | Other |
> g Contoct Q% 000X B F WH
..[8[ Contacts -‘— @1] High School Graduation Year:  /n Mative Language: Ed. Degres:

- Addresses Religion: Business P.O.C.: High School Attended:

@ Households o _
Church Affiliation: 1=t Child Name: i :
[ Contact Relationships User Field 11:

- 4y Contributions/Pledges Ethnicity: 2Znd Child Mame: User Field 12
4 Product Sales
-2 Communications

7-¢i Financial

- System Manager

| Favorites | General | Address | Household | Attribute | Canvass | Relation | Contrbute | Pledge | Event | Sales | Log | Admin | SQL |

<System Format>

Columns...

Select saved... —_— ———— i
Add or remove columns, apply formatting, or specify column attributes.

Aakhus Save 1708 5th 5t S Moorhead WA 56560
Aakhus i Save fs... 19981 See Gull Rd Brainerd AN 5401
Aakhus . 19951 See Gull Rd Erainerd MM 56401
Assign as default...
Aamot 13451 Mcginty Rd E Minnetonka MM 55305
Aanenson i Home 3596 White Bear Ave ‘White Bear Lake | MHN 55110
Aananson Haome 59331 155th 5t Rose Creek MM 55970

Abbott i ari Home 5533 Concord Ave Edina RN 55424

[ =] =] =] = | =]

<]
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Select the user fields you want to add into your format by selecting them from the list of columns (they’ll be renamed to whatever you named them
to in section No1) and click [OK]. In my example | selected a single user field which was the High School Graduation Year.
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1. Locate the user fields in the list of column selection list that you
want to add into your report.

T
@ Column Selection

Columns | Attributes | Format |
Table Columns [Contacts]

% GuaranteeTotal
GuaranteeTotalBeforePeriod

GuaranteeTotal ThisPeriod
GuaranteeTotal ThruPeriodEnd
GuaranteeTotalYearT hruPericdEnd
HasVoted

High School Attended

High School Graduation Year

les HouseholdID

=) Contacts HouseholdNatRecord
[ User IfCAandCommittiwhols TreasurerMoter D

B} Address [Default Display] :mm:?
1 |y =
E{I@ Addresg [Home] |m$rtﬂeferenbe|’(£‘h’
) Nation Include
IncludeFlag
IsHousehaoldMember1

- Address [Mailing]
.. Addrece [Renictrstinn ]

17
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The column(s) will populate on the far right of the grid.
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Il “3# Search &Reset dE New
QD

| Favorites | General | Address | Household | Attribute | Canvass | Relation | Contribute | Pledge | Event | Sales [ Log | Admin | saL |

0= | L) ¥ @ | File » Edit ~ | 0 | SmInclude Other | Contacts

| Name | Phone | E-Mail | Email Links | Profie | Wark | Demographics | User. Text | User, Dates | User, Degimal | Other |

O% @O0 0| X B =G e|sa

@ High School Graduation Year: Jniv Mative Languags: ~ Ed. Degres:
Religion: + Business PO.C.: * High School Attended:
Church Affilistion: ~+ stChildName: User Field 11:
Ethnicity: = 2ndChild Name:  UserField 12

late

select will pop

Ind 1D Last Name = First Name I ?fpde"e“ Address [ Display Summary view. State g’de ;'r?‘;"nee Email zirgzusa;ro"n"'har
| B | R Home  |4629 York Ave § [[Minneapoiis MH 55410 (6129209217 ||| Martha@Aagard.com [[ 1965
3 Aakhus m Marie Home 1709 3th 5t 5 Moorhead 56560 [218) 5259215 Ariel@Aakhusiooncom 2007
4 Aakhus Cindy Lee Home 19931 See Gull Rd Brainerd AN 56401 (218) 8289215 1962
3 Aakhus Steven Eric Home 19951 See Gull Rd Brainerd MM 56401 (218) 5289215 Steven@Aakhus.com 1962
[ Aamot Earbara A Home 13451 Mecginty Rd E Minnetonka MM 55305 [952) 9335423 Earbara@Aamot.com 1935
i Aanenson Pamela Marie Home 3896 White Bear Ave White Bear Lake | MM 55110 [651) 426-9611 Pamela@Aanenson.com 1965
g Aanonson Leland Eugene Home 58331 155th 5t Rose Creek MM 55970 (507) 4345229 Leland@Aanonson.com 1953
9 Abbott Gina Marie Home 5533 Concord Ave Edina M 55424 [952) 9299217 1963
10 Abbott Steven William Home 5533 Concord Ave Edina MM 55424 [952) 9299217 1970
11 Abdi Al Hassan Home 206 62nd 5tW Minneapaolis MM 55419 (612) 432-53920 Ali@Abdi.com 1982
12 Abdi Halima Mohamed Home 2904 15th Ave 5 Minneapaolis MM 55407 [612) 43255824 1974
13 Abdi Nimo Mohamed Home 1201 Brook Ave SE Minneapaolis MM 55414 [612) 5328525 1987
14 Abdulali Quaid Home 3408 Stevens Ave 5 Minneapolis M 55408 [612) 8219310 1975
14178 Abdullahi Rachel Home 2437 15th 5t NW Washington DC 20009 2007
15 Abdurahman | Ayan Adan Home 811 28th Ave 5 Minneapaolis MM 55454 [651) 645-7234 1965
16 Abel Tasha Margaret Home 303 Fairview Ave Fairmont MM 56031 (502) 235-5827 Tasha@Abel.com 1975
13008 Abell lames I Home 2040 Holly Swamp Rd Pacomaoke City MDD 21351 2007
13600 Abernathy EBetty 1 Home 2411 Fairway Oaks Ct Hampstead MD 21074 2007
17 Abouaish Yasming Y Home 1432 Brookshire Ct Mew Brighton MM 55112 [763) 742-7139 Yasmine@Abouaish.com 1959
19 Abrahamian Daniel Paul Home 6012 Beard Ave 5 Edina MM 55410 [952) 92999158 Daniel@Abrahamian.com 1990
20 Abrahamian David Home 6012 Beard Ave 5 Edina MM 55410 (952) 9299913 David@Abrahamian.com 1962
21 Abrahamian Eelli Ann Home 6012 Beard Ave 5 Edina MM 55410 [952) 9299918 Kelli@Abrahamian.com 1962
13252 Abrahams Audrey C Home 11 N Main 5t Port Deposit MD 21904 2007
o = | 99 Ahrabhamecnn Branar BAark Hoama E147 2 T+h Ava © hMinnaannlic RARI ECA17T BINEIZT QM= 1gE7
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Repeat these steps until the user fields that you want to add are added, and the columns you don’t need in your report have been removed. My
finished example is below which includes all of the user fields I’'ve renamed in my database in a single report.
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Example custom user field report.

w32 Search %, Reset | <k New 05 L) ¥ @ | File » Edit | 0 |SgInclude Other | Contacts
Q

| Favorites | General | Address | Household | Attrbute | Canvass [ Relation | Contribute: | Pledge | Event [ Sales [ Log [ Admin | saL |

| Name | Phone | E-Mail [ Email Links | Profile | Work | D hics | User. Text | User, Dates | User, Decimal | Other |
@ High School Graduation Year:  /n ~ MNative Language: ~ Ed. Degree:
Religion: » Business POC.: +  High School Attended:
Church Affiliation: + 15t Child Name: User Field 11:
Ethnicity: *  2nd Child Name: User Field 12:

User defined fields after they've been added to the grid.

EE Edit | % Include %% Exclude @Sort @Format - lagExpor‘I: &Print

[ Summary D] B

Pivot

. . - - . Mative Laioh School . 15t. an Business
Inc  Last Mame -~ First Name City State | Religion Church Affiliation Ethnicity Language Ed. Degree Graduation High School Attended Child Child P.CLC.
Year Mame Mame
Aagard Martha Minneapaolis MM Christian Caucasian English Masters Degree 1958 Fridley High Schoal EBobby J
Aakhus Ariel Moorhead MHN English 2007 Chaska High School
Aakhus Cindy Erainerd MM Baptist Elim Baptist Church Asian 1958 ‘West Lutheran High School | John
Aakhus Steven Erainerd MHN Chinese English 1962 Princeton High School
Aamot Earbara Minnetonka MM Christian Calvalry Lutheran Church Asian English 1935 Princeton High School Bob Sarah
Aanenson Pamela ‘White Bear Lake | MN Christian African American 1955 Chaska High School
Aanonson Leland Rose Creek MM Amish Caucasian English Masters Degree 1953 Princeton High School Terresa
Abbott Gina Edina MM Islam Emmaus Lutheran Church 1963
Abbott Steven Edina MM Caucasian English 1970
Abdi Ali Minneapaolis MM African American 1952 Kim
Abdi Halimo Minneapaolis MM Caucasian English 1958 Pease Academy
Abdi Mimao Minneapaolis MM Christian Calvalry Lutheran Church English 1987
Abdulali Quaid Minneapaolis MM Slavic neopaganism Chinese G.ED. 1975
Abdullahi Rachel Washington DC Calvalry Lutheran Church African American English 2007
Abdurahman Avan Minneapaolis MM Gasin faith (Korean) Caucasian English 1965 Thistledew School
Abel Tasha Fairmont MM Amish Hindi Masters Degree 1975 St. Peter High School
Abell Jlames Pocomoke City MD African American English Masters Degree 2007
Abernathy Betty Hampstead MDD Caucasian 2007 Paladin Career and Technic... | Franky Tim Dir. Earl
Abouaish Yasmine Mew Brighton MM Emmaus Lutheran Church | African American English 1989
Abrahamian Daniel Edina MM Emmaus Lutheran Church English Masters Degree 1930
Abrahamian David Edina MM Calvalry Lutheran Church English 1962 Qur Lady of Lourdes
Abrahamian Kelli Edina MM Caucasian English High School Diploma 1962 Truman High School
Abrahams Audrey Port Deposit MD Islam Calvalry Lutheran Church Asian English Doctorate 2007
Abrahamson Roger Minneapolis MM Gasin faith (Korean) Caucasian English Masters Degree 1952 Truman High School
Abukar Halima Minneapolis MM Mormon Asian 1958 West Lutheran High School
A 9,248
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You can save these formats for future use and also assign it as a default if you want.

Another useful thing you can do is make these fields ‘Updatable in the Grid View’ by going into the Format tab of the Column Selection screen and
checking the corresponding boxes. Shown in the screenshots below.

Img 1 of 3 — Open Up the Formatting Screen
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Ethmicity: »  2Znd Child Name:

ra

ser Figld 12:

S8 Edit | % Include % Exclude 7 Sort |EEF Format ~ DE Export &F‘rint [ Detail (@] Summary [D E [E Pivet |
Cotom User e
|@ Columns... |
Incl  Last Mame 4 First Name ‘E’ Select saved... iyl Church Affiliation Ethnicity Taar:;
Add or remove columns, apply formatting, or specify colurnn attributes. l

Aagard Martha ko Save &n Caucasian Englis
LT Ariel ‘E Save As.., Engli:
Aakhus Cindy @ Assign as default... Elim Baptist Church Asian
Aakhus Steven Erfainerd TArT Chinese Englis
Aamot Earbara Minnetonka MM Christian Calvalry Lutheran Church Asian Englis
Aanenson Pamela White Bear Lake | MM Christian African American
Aanonson Leland Rose Creek MM Amish Caucasian Englis
Abbott Gina Edina rAMN Islam Emmaus Lutheran Church

Img 2 of 3 — Navigate to the Format Tab and Check the Boxes for Updateable

KNOWLEDGE BASE www.trailblz.com/kb
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9 Column Selection v =SEC
— . s —— i ——
| Columns | mnﬂlj Format -
Format
=£

Column Heading Filter Wisible  Width  Froz Updatable Tgpe Subtype
Phone_Home Home Phone 85 Tlxt Fhone Mum
Phone_Bus Bus Phone 85 TIth Phone Mum

! Phone_Cell Cell Phone 85 Phone Mum
Emailaddress Email 144

I Religion Religion
Church Affiliation Church Affiliati... &
Ethnicity Ethnicity
Mative Language Mative Language

] Ed. Degree Ed. Degree

| High School Graduation Year High School G.. L

L High School Attended High School A.. 1

| 1st Child Name 1st Child Mame

L 2nd Child Name 2nd Child Mame

1 Business P.OLC. Business P, O, C,

I Employer Employer/Comp... e

|

|

|

: Progress

: |

i

' 3

! ——

| @ ok |

) Cancel l
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Img 3 of 3 — Click the [Edit] Button and Modify the Data in the Grid View
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Contacts [ 9246 records found |

Allow Updates

<3» Search %, Reset | & New 09 | L) CF (| File + Edit - | © | g Include Other | Contacts
Iy
| Favarites | General | Address | Household | Attrbute | Canvass | Relation | Contribute | Pledge | Evert | Sales [ Log | Admin | SOL |
| Name | Phone | E-Mail | Email Links | Profile | Work | Demographics | User. Text | User, Dates | User, Decimal | Other |
9
@ High School Graduation Year:  /n + Mative Language: « Ed. Degree:
Religion: « Business PO.C. = High School Attended:
Church Affiliation: » 1st Child Name: User Field 11:
Ethnicity: +  2Znd Child Name: User Field 12:
S The cells turn green allowing you to
»

% Include % Exclude | B Sort B Format - | &% Export % Print

update them in the grid view.

@ Summary []] =

Pivot

Ind Last Mame = First Name City State  Religion Church Affiliation Ethnicity LNaa::r:age Ed. Degree ?rgzg;ihoono' High School A
ear

Aagard Martha Minneapolis MM Christian Caucasian I English Nsters Degree 1958 Fridley High Sch
Aakhus Ariel Moorhead MM English 2007 Chaska High Sck
Aakhus Cindy Erainerd MM Eaptist Elim Baptist Church Asian 1958 ‘West Lutheran K
Aakhus Steven Erainerd MM Chinese English 1962 Princeton High ¥
Aamot Earbara Minnetonka MM Christian Calvalry Lutheran Church | Asian English 1935 Princeton High ¥
Aanenson Pamela White Gear Lake | MN Christian African American 1958 Chaska High Sck
Aanonson Leland Rose Creek MM Amish Caucasian English Masters Degree 1953 Princeton High !
Abbott Gina Edina (1] Islam Emmaus Lutheran Church 1963

Abbott Steven Edina MM Caucasian English 1970

Abdi Al Minneapuolis MM African American 1982

Abdi Halima Minneapuolis MM Caucasian English 1958 Pease Academy
Abdi Mima Minneapuolis MM Christian Calvalry Lutheran Church English 1987

Abdulali Duaid Minneapolis MM Slavic neopaganism Chinese G.E.D. 1975

Abdullahi Rachel Washington DC Calvalry Lutheran Church | African American English 2007

Abdurahman Ayan Minneapuolis MM Gasin faith (Korean) Caucasian English 1965 Thistledew Scho
Abel Tasha Fairmont MM Amish Hindi Masters Degree 1975 5t. Peter High 5
Abell James Pocomoke City MD African American English Masters Degree 2007

Abernathy Betty Hampstead MD Caucasian 2007 Paladin Career a
Abouaish Yasmine Mew Brighton MM Emmaus Lutheran Church | African American English 1989

Abrahamian Daniel Edina MM Emmaus Lutheran Church English Masters Degree 1990

Abrahamian David Edina MM Calvalry Lutheran Church English 1962 Cur Lady of Lou
=1 o . P . B . .
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#4 — Utilize User Fields as Merge Fields in your Letter & E-Mail Templates

User fields are available as merge fields in both the email system and the mail-merge system. In the email composer the *TEXT* user fields are
the only ones available, in a physical letter *ALL* merge fields will be available.

To utilize them in an email, create either a template or a mass email campaign, and the user fields will display in the merge field drop-down list.

My example campaign is below.
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File - Edit ~ i Saved Copies [@] Results @ B9 & | Eblast to Alumni

jkristenson@trailblz.com
5049 Recipient(s)

Subject:
_Edit | Save | B9 Insegp®mplate | Save Template | Priority Mormal - [C] Forward to Friend [7] Unable-to-Resd Link

Filter Content

-

|Ir|sert merge field...

------------------- .
«EmailAddresss OB E e Q by | = | R
sAlEmailAddresss
Otph »

aone_Alt T,
«Phone_Cell»
«Phone_Homes )
=Phone_Faxs P e - Size - || A- B-| .
«Phone_Buss
«Phone_BusFax.
«ContributionLastDates
«ContributionLast4mounts

o
-
82
m
Jih
Il
i

T E- e s B @ Q=

Some readers see this part of your email

The 12 user text Write something brief and catchy, comg

e fields are availble

allserlld . - 1 -
wUser005» in Trail Blazer's email

allser0bn 3
=User)07x composer.

allser)08x
aUser)0%
allserd10x imagﬂ
aUserl1ls - X
allser]l 2.

m

ocMMfrddfm}f:o
MMMM dd, yyyy» -
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Here’s what the user text merge fields will look like as they’re added into your email message:
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Headline for your Newsletter

Article Headline

This is what the merge fields will looks like (it's important to verify you are using the correct ones
by running some test emails prior to sending):

alUser0D1»
aUserli2»
alJserl03»
aUserlD4»
alJserlDon
alUser006»
aUserl07»
alJserl0G»
alUser00%9
alJserl10»
alUserl11»
aUser(12»

The user text merge fields will look like
this as you add them into your email.

/
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When you create physical letter templates for your snail-mail efforts you’ll be able to utilize *ALL* of the user fields (text, decimal, and date fields),

the image below provides an example of where you’ll insert them from:
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BHU A& +EEE AEDO4 == Insert merge field.. |=|| [ [ "V | &

«Tax Deductible Contribution Table Within Date Ranges -
=Fund Allecation Takle Within Date Range=»
«Pledge Totale
«Pledge Open Total»
=Employers
=lobTitles
«WorkPhones
When you create VoterNumbers
—LcailBlaze D,
H allzerl0] =
a physical letter T
allserl03=
tempate ALL of the | =%
- - «l)serll 5
user fields will be User006

- allserl07 s
available for use. wUser008
al )zl
allsef10= =
allsellls
allserlldn
allserDatell=
allserDatel2s
allserDatel3s
allserAmount]ls
allserfmountlZs
allserfmountl3s

m

Frr

MMM dd, yyyy»
wyyMMdds -
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Here’s my example print preview using all of the user field merge-fields in the system (prior to the print preview):
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BEH 0B +EEE0 AEBDD4 = &= | eUserfmount3 - |[H & "V |2
Example print preview with the user fields being merged:

User Text Fields

High School Graduation Year: «User001»

Religion: «User002»

Church Affiliation: «User003»

Ethnicity: «User004»

Native Language: «User005»

Business P.O.C. «User006»

1st Child Name: «User007» .
2nd Child Name: «User008» Example letter template with

Ed. Degree: «User009» all merge fields being used prior

High School Attended: «User010» . . .
Not Defined: «User011» to running the print preview.

Not Defined: «User012»

User Date Fields

Leaves for Winter Home: «UserDate0Q1»
Membership Expiration: «UserDate02»
Not Defined: «UserDate(3»

User Decimal Fields

34

Not Defined: «UserAmount01»
INot Defined- «lserAmountl?x
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And here’s what my example looks like after the print preview is generated:
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Example print preview with all available merge fields.

0 @ 1 Q @ r,s Print Settings

Example print preview with the user fields being merged:

User Text Fields

High School Graduation Year: 1958
Religion: Christian

Church Affiliation:

Ethnicity: Caucasian

Native Language: English
Business P.O.C. Bobby J

1st Child Name:

2nd Child Name:

Ed. Degree: Masters Degree

High School Attended: Fridley High School
Not Defined:

Not Defined:

User Date Fields

Leaves for Winter Home: August 01, 2007
Membership Expiration: August 01, 2014
Not Defined: June 06, 2079

36
User Decimal Fields

Not Defined: $0.00
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Take a look at the related resources below for links to a variety of similar articles and videos.

999

Trail Blazer

- YouTube Channel
- Knowledge Base Articles
- 3rd Party Resources

KNOWLEDGE BASE www.trailblz.com/kb
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Related Resources

Article: Mass Update — Changing or Clearing Fields

Article: Log Notes vs User Fields vs Attributes

Article: Add Attributes, Attribute Dates, and Attribute Notes to the Grid by Formatting them in as Columns
Article: (Mail-Merge) — How to Write a Letter, and Save it as a Template

Article: Articles on Importing
Article: Mail Merge — Write a Letter
Article: Creating and Saving Default Formats for Reporting with the Grid

Video: Eblasts Create and Send Eblasts — Includes Image Management

Video: Donation Auto Responders with Merge Fields
Video: Write Letter — Edit Letter after Mail Merge
Video: Videos on Importing

Trail Blazer Live Support
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© Phone: 1-866-909-8700
® Email: support@trailblz.com

E? Facebook: https://www.facebook.com/pages/Trail-Blazer-Software/64872951180
B Twitter: https://twitter.com/trailblazersoft

* As a policy we require that you have taken our intro training class before calling or emailing our live support team.
Click here to view our calendar for upcoming classes and events. Feel free to sign up other members on your team for the same training.

* After registering you’ll receive a confirmation email with the instructions for how to log into the GoToMeeting session where we host our live
interactive trainings.

* This service is included in your contract.
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